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Introduction
This Release Notes document summarizes the FlexNet Operations 2021 R1 On Premises release and it 
subsequent point releases. 

• Features and Enhancements

• System Requirements

• Resolved Issues

• Known Issues

• Special Notes

• Legal Information

Note • For additional details about the changes, contact Revenera support. 

Resources
The following resources can help you stay up to date with FlexNet Operations news and product 
knowledge:

• In addition to providing case management, the Revenera Community site can help you quickly find 
answers to your questions by searching content from other customers, product experts, and 
thought leaders. You can also post questions on discussion forums for experts to answer. For 
each of Revenera’s product solutions, you can access forums, blog posts, and knowledge base 
articles. You can also access the Product and License Center from the Community’s Other 
Resources menu to download Revenera products.

• You can find documentation for FlexNet Operations and all other Revenera products on the 
Revenera Product Documentation site.

• The Revenera Learning Center offers free, self-guided, online videos to help you quickly get the 
most out of your Revenera products. You can find a complete list of these training videos in the 
Learning Center. 

• Customers who have purchased a maintenance contract for their product(s) can submit a support 
case or check the status of an existing case by making selections on the Get Support menu of the 
Revenera Community:

https://community.revenera.com

https://community.revenera.com
https://docs.revenera.com
https://learning.revenera.com
https://community.revenera.com
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FlexNet Operations Videos
These brief, informative videos walk you through the getting-started exercises found in the FlexNet 
Operations User Guide (online help or PDF version). We recommend that you first read the appropriate 
“Getting Started” section in the User Guide to gain an understanding of the concepts it covers, and 
then click the section title in the table below to view the video  

Features and Enhancements
Features and enhancements were added to the following areas of FlexNet Operations On Premises in 
the 2021 R1 release:

• Account and User Management Enhancements

• Device Management Enhancements

• Download Package Management Enhancements

• Electronic Software Delivery Enhancements

• Email Notification System Enhancements

• Entitlement Management Enhancements

• Export and Import Enhancements

Guide Topics

Getting Started with 
Entitlement Management

Creating an account, a user, a product, and an entitlement. 

Getting Started with FlexNet 
Embedded Licensing

Setting up a publisher, identity, and a licensed product. Creating a 
device and activating its license. Creating and provisioning FlexNet 
Embedded license servers. 

Getting Started with 
Electronic Software Delivery

Creating a producer and download packages, associating 
download packages with a product, creating files, associating files 
with download packages, and viewing and downloading files from 
the FlexNet Operations End-User Portal. 

Getting Started with Usage 
Management

Creating a usage-based license model, a feature, a product, and an 
entitlement. Obtaining the license server URL to which the usage 
data is sent. Running a usage-capture client. Viewing usage 
information graphs and gauges.

Getting Started with FlexNet 
Publisher License File-Based 
Licensing

Activating and returning a certificate license.

Getting Started with FlexNet 
Customer Growth

Customer growth concepts and configuring notifications for 
expiring entitlements and expired entitlements. 

https://youtu.be/L_DJynsiCRs
https://youtu.be/6-juN9F9OBo
https://youtu.be/qR2kOl6Cojg
https://youtu.be/1rPRl-NKgJY
https://youtu.be/-OHqqD62fyk
https://youtu.be/u0oCCN-iXJU
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• License Management Enhancements

• SOAP and REST Web Services Enhancements

• System Administration Enhancements

• User Experience Enhancements

• General FlexNet Operations Enhancements

Account and User Management Enhancements
This section describes the enhancements introduced in 2021 R1 for managing accounts and users:

• Configurable Display of “Created By” Column for Accounts in the End-User Portal

• New Permissions to Control Producer-Management of Other Users

• Allowing Additional Users on Self-Registered Accounts

• Control Over Editing Account ID and Account Name in the End-User Portal

• Control Over Creating Customer and Partner Accounts in the End-User Portal

Configurable Display of “Created By” Column for Accounts in the End-User 
Portal
Revenera Support can now help you hide the Created By column on the Accounts page in the End-User 
Portal. (By default, the column is visible.) Contact them if you need to hide (or later redisplay) this 
column.  

New Permissions to Control Producer-Management of Other Users
This enhancement enables Producer users to manage Customer and or Partner users, independently 
of managing other Producer users. Previously with the single View and Manager Users permission, 
Producer users had access to modify all User types in the system, and could not be constrained to just 
Partners or Customers. In this release, the following user-management permissions have been added 
to define a Producer role: 

• View and Manage Customer Users—Enables the Producer user to create and manage only 
Customer users.

• View and Manage Partner Users—Enables the Producer user to create and manage only Partner 
users.

These new permissions provide a control for the types of users that a Producer user can manage. (This 
might be necessary, for example, to comply with internal security measures.)

If the Producer user is assigned the View and Manage Users permission, the other two permissions are 
ignored since they are folded into the View and Manage Users permission. However, if the Producer 
user is configured with either or both of the new permissions, but not with the View and Manage Users 
permission, the producer can manage the only type of users specified by the selected permission(s); 
the producer cannot manage other Producer users.   
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Important • The Producer user also requires the View and Manage Accounts permission to manage 
users using any of these three user-management permissions. Without this “umbrella” permission, the 
Producer user cannot create users or save updates, view transaction histories (updates, deletes, or so 
forth), or reset passwords for those user types that the producer has permission to manage. 

Allowing Additional Users on Self-Registered Accounts
At initial login, End-User Portal users have been able to self-register themselves and the organization 
to which they belong as long as they have an entitlement or activation ID. This dual registration of the 
organization and the user is performed from the Register for Account page, available through the 
Register option on the End-User Portal login screen. However, in previous releases, a user could not 
self-register with an existing self-registered account. 

In this release, a user can now self-register with an existing self-registered account at initial login. A 
new option, Register for existing Account, has been added to the Register for Account page to allow 
this type of registration. The user is automatically added to the self-registered account identified by 
the entitlement or activation ID.

Additionally, to control the availability of this new option on the Register for Account page, a system 
administration option, Enable Self-Registration for an existing Account, has been added to the System 
> Configure > End-User Portal Setup page.  

Control Over Editing Account ID and Account Name in the End-User Portal
The End-User Portal allows users to edit their account ID and account name. However, for some sites, 
this capability is not desirable. To address this issue, a new system administration option has been 
added in the Producer Portal to enable or disable the end users’ ability to update the account ID and 
name. The option, Prevent editing of Account ID and Account Name, is available in the Manage 
Accounts & Users section of the End-User Portal Setup configuration page in System > Configure. This 
option is disabled by default to maintain the behavior of previous releases.  

Control Over Creating Customer and Partner Accounts in the End-User Portal
The End-User Portal allows users to create customer or partner accounts. Some sites prefer not having 
end users create accounts. However, they still want these users to assign account users and perform 
other account management tasks. Disabling the end-user permission to manage accounts prevents 
users from creating accounts but also prevents them from performing other account management 
tasks. To address this issue, a new system administration option has been added in the Producer 
Portal that enables or disables the end users’ specific permission to create customer and partner 
accounts in the End-User Portal. The option, Hide Create an Account, is available in the Manage 
Accounts & Users section of the End-User Portal Setup configuration page in System > Configure. This 
option is disabled by default to maintain the behavior of the previous releases.  

Device Management Enhancements
This section describes the enhancements introduced in 2021 R1 for managing devices.
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Site Name Now Editable After Device Creation
The Site Name property for a standalone or server device enables the user to identify a sub-section of 
a company account, such as the location to which a device is delegated. Previously, this field was 
available when creating the device. However, once the device was created, users could no longer edit 
this value.

In this release, the Site Name field is now editable after a device is created in either the Producer 
Portal or the End-User Portal. To allow editing of this field in the End-User Portal, the system 
administrator must select the new configuration setting, Allow site name editing, under System > 
Configure > End-User Portal Setup > Devices Page. 

This setting is processed only when the Display Site Name in device pages is also selected.  

Package Downloads Now Enabled from the “Device Details” Page for 
Standalone Devices
The Device Details page for a standalone device, which currently shows tabs for the Overview and 
Updates information relating to the device, has been enhanced to add a third tab, Downloads, for 
displaying the downloads available to the device. This new tab enables Producers and Customers to 
determine in a single view what software downloads in Electronic Software Delivery can be installed on 
the device and to navigate to any of the Download Package details pages in order to download specific 
files.

Optionally, a button can be displayed on the Downloads tab that allows all files for selected download 
packages to be downloaded in a single archive directly from the tab.

The new Downloads tab is not visible by default, but is enabled by means of a new system 
configuration setting, System > Configure > End-User Portal Setup > Devices Page > Show Downloads 
Tab.

Similarly, the button to download all files for selected packages directly from the Downloads tab is 
enabled by a separate system configuration setting, System > Configure > End-User Portal Setup > 
General Options > Show Download Button. This setting is applied only if the previously described Show 
Downloads Tab setting is enabled.  

Ability to Remove Accounts from a Device
You can now disassociate an account from a device so that the device can be assigned to another 
account. Previously, you could not obsolete or reset a device because you could not remove its 
account.  

Customer Account Now Optional for Devices
Previously, associating a standalone device with a customer account was required when creating (that 
is, registering) the device in the Devices UI in the Producer Portal. In this release, customers now have 
the option to create a standalone device without associating it with an account. This type of device is 
known as an anonymous device (a term used to describe this kind of device type but not actually used 
in the UI).  

Note • Associating a device with a customer account has always been optional in SOAP Web Services. 
However, anonymous devices cannot be created in nor are visible in the End-User Portal.
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Download Package Management Enhancements
The following enhancements to the management of download packages were added in the 2021 R1 
release.

SHA2 Checksum Available for Uploading Files
Previously, when preparing to upload a file for association with a download package, producers could 
provide the file’s expected MD5 value on the Upload File page. This value was then compared with the 
MD5 of the file once it was uploaded to ensure that the file had not changed during the upload. 

Producers can now also provide the file’s expected SHA2 checksum value when performing an upload. 
They can provide both the SHA2 and the MD5 values or one or the other value to ensure that the pre-
uploaded file and uploaded file are the same. Note that this SHA checksum option is available only 
when performing an HTTP or FTP upload (from the HTTP Upload or FTP Upload tab, respectively).  

File Downloads Now Performed on Separate Tabs
When users click the link to download a file from the Downloads page in the End-User Portal, the 
download now opens to a new tab, enabling users to navigate between tabs during multiple 
downloads.  

Electronic Software Delivery Enhancements
The following enhancements to Electronic Software Delivery (ESD) were added in the 2021 R1 release.

Downloads Now Visible in End-User Portal for Users Who Reset Their 
Passwords
Previously, if an end-user’s account was deactivated due to multiple invalid login attempts and the 
user then reset their password, the Electronic Software Delivery module was not made aware of this 
account change. As a result, in the End-User Portal, the user could no longer view downloads 
associated with entitlements to which that user had access. Electronic Software Delivery will now be 
made aware of such changes, so that end users can continue to access downloads.  

“Download Packages” Page Now Accessible for Multiple Selected 
Entitlement Line Items Belonging to Different Accounts
Prior to this release, when a user in the End-User Portal selected multiple entitlement line items 
belonging to various accounts and then clicked View > View Download Packages, the following error 
message was displayed: “The selected activation ids should belong to the same account Id.” The 
Download Packages page was not opened.

Now, when the user selects this option for multiple lines items belonging to various accounts, no error 
message is displayed. Instead, the Download Packages page is opened, enabling the user to view and 
download packages associated with these accounts. A dropdown above the grid on the page lets the 
user select the account for which to list download packages.  



FlexNet Operations 2021 R1 On Premises Release Notes  (November 2021) Company Confidential 9

“Download Packages” Page Now Accessible for Multiple Selected 
Entitlement Line Items When Some Items Have No Downloads
Previously, when a user in the End-User Portal selected multiple entitlement line items—one or more of 
which had no associated download package—and then clicked View > View Download Packages, the 
following error message was displayed: “Some of the activation ids selected do not have download 
packages.” The Download Packages page was not opened.

Now, when the user selects this option for multiple lines items, some of which do not have associated 
download packages, no error message is displayed. Instead, the Download Packages page is opened, 
showing the download packages for those selected line items that have packages. However, if none of 
the selected line items are associated with download packages, the error message is displayed.  

Email Notification System Enhancements
The following are enhancements were introduced for email notifications in 2021 R1 release.

• Support for Account-level Custom Attributes in Entitlement, Entitlement Certificate, and Reset 
Password Email Templates

• New Column to Track the Date of Last Change to an Email Template

• New Merge Tag for Email Recipients

• Single Email Notification for a Product with Multiple Line Items During Bulk Entitlement Upgrade

• Accounts and User Custom Attributes Available for Use as Merge Tags

Support for Account-level Custom Attributes in Entitlement, Entitlement 
Certificate, and Reset Password Email Templates
The Entitlement, Entitlement Certificate, and Reset Password email templates now support account-
level custom attributes. One or more of the custom attributes can be used to define conditions in the 
template that control the content sent to the users of different accounts. The templates include FOR-
EACH tags that can be used to iterate through the accounts to read the values of the custom 
attributes.  

New Column to Track the Date of Last Change to an Email Template
A Date Modified date/time column has been added to the List Email Templates and List All Versions 
pages for email templates. This value reflects the date of the latest content update to a given template 
(active or draft version) in the list. The value does not reflect the date of the latest update to the 
template’s definition (for example, an update to the template’s variation name or any other editable 
attribute). 

Note that the Date Modified column value remains blank until the content for the email template is 
updated for the first time after this release.  

New Merge Tag for Email Recipients
A new merge tag RecipientName is available in the Entitlement and License email templates. This tag 
ensures that the correct name is used when addressing individual recipients in the emails triggered 
after the completion of a bulk entitlement operation.  
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Single Email Notification for a Product with Multiple Line Items During Bulk 
Entitlement Upgrade
When a bulk operation does an upgrade for entitlements, end users are sent a single email for each 
upgraded line item within a single entitlement. Previously, however, due to this system design, when 
the same product existed on multiple line items within a single entitlement, end users received 
multiple email notifications for the same product.

Now, when multiple entitlement line items for the same product within a single entitlement are 
upgraded during an entitlement bulk upgrade operation, users receive a single email notification is for 
the product, not a notification for each upgraded line item.

Note • This update is not supported when multiple lines items for the same product within multiple 
entitlements in a given account are upgraded using a bulk operation.  

Accounts and User Custom Attributes Available for Use as Merge Tags
Account and User custom attributes ([[ACCOUNT_CA]] and [[USER_CA]], respectively) can now be used 
as merge tags in the “Welcome” email template. Additionally, a FOR-EACH merge tag has been 
included to iterate through the Account custom attributes.  

Entitlement Management Enhancements
This section describes the enhancements introduced in 2021 R1 for managing entitlements:

• Improved User Experience When Attempting to View Download Packages for Entitlements Without 
Associated Downloads

• Entitlement Search by Contact Email Address

• Multiple Package Downloads from Entitlement List in End-User Portal

• New Parameter to Control Inactivating or Obsoleting Entitlements and Line Items Currently Used 
by Devices

Improved User Experience When Attempting to View Download Packages for 
Entitlements Without Associated Downloads
Users on the List Entitlements page in the End-User Portal can select View > View Download Packages 
to view and download the download packages associated with multiple entitlement line items 
currently selected on the List Entitlements page. 

Previously, if any of the selected line items were not associated with a download package, users 
received a error message, forcing them to deselect those line items that had no associated download 
packages before they could proceed to view the download packages for those items that had. 
(Entitlement line items that have an associated download show a Download Now link in the Downloads 
column on the List Entitlements page.)

Now, when users select to view the download packages for multiple line items, some of which do not 
have an associated download, the Download Packages window proceeds to open, listing the 
downloads for only those line items that have associated downloads. The previous error message that 
prevented users from proceeding to view the Download Packages window is no longer presented.
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If none of the selected line items have associated download packages, a pop-up message on the List 
Entitlements page lets you know.  

Entitlement Search by Contact Email Address
Users can now filter entitlements by the email address of the contact associated with the sold-to 
account for entitlements. The following new items are available to enable the use of this new filter:

• A new Contact Email option in the Search for field on the List Entitlements by Order page

• A new optional contactEmail parameter for the getEntitlementsQuery method in the V4 
EntitlementOrderService web service  

Note • For partner accounts, the search base on the contact email address works for those accounts 
that belong to the endCustomer tier type.

Multiple Package Downloads from Entitlement List in End-User Portal
Previously, users were required to perform software downloads for entitlement line items on the List 
Entitlements page one line item at a time. In this release, users can now perform software package 
downloads for multiple line items selected on the List Entitlements page or opt to download selected 
files within a given download package. (All selected entitlement line items must belong to the same 
account and have downloads available.)

To initiate the download process, users select the new View > View Download Packages option on the 
List Entitlements page. This option opens the Download Packages window, enabling users to view a 
list of the software download packages available for the selected line items and then download 
selected (or all) packages. Alternatively, users can click a package link from this window to obtain a list 
of all the files contained in the package, and, from this list, select specific (or all) files to download. 
Compliance checks are performed before any download starts.

Users must have the existing Get Downloads permission to perform these software downloads.

The new View Download Packages option is not visible by default, but is enabled by means of a new 
system configuration setting in the Producer Portal, System > Configure > End-User Portal Setup > 
Entitlements Page> Show View Download Packages.

Similarly, the button to download all files for selected packages directly from the Download Packages 
window is enabled by a separate system configuration setting, System > Configure > End-User Portal 
Setup > General Options > Show Download Button. This setting is applied only if the previously 
described Show View Download Packages option is enabled.  

New Parameter to Control Inactivating or Obsoleting Entitlements and Line 
Items Currently Used by Devices
When an entitlement or line item is made Inactive or Obsolete, the licenses currently activated on a 
device (license server or standalone device) by that line item or entitlement remain on the device until 
they expire.
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If this behavior is not desired, it is now possible to prevent the line item or entitlement from being 
made Inactive or Obsolete by setting the System Configuration option Allow used entitlement/line 
item state change to Inactive or Obsolete to false. An error message will then be displayed if an 
attempt is made to make such a line item or entitlement Inactive or Obsolete. (The option is located 
under System > Configuration > FlexNet Operations > General Options.)  

Export and Import Enhancements
The following enhancement to the Data Export and Import functionality was added in 2021 R1.

Ability to Export a Single Entitlement into a Template for Import
Previously, to import a single or selected entitlements into a template for data import, users had to 
export the entire entitlement base. A new import option now makes it possible to export selected 
entitlements into a template for import.  

License Management Enhancements
This section describes the 2021 R1 enhancements to license management and models.

New Configuration Option to Batch-Rehost All Fulfillments
Currently, during a Batch Rehost process, if a producer selects to rehost fulfillments from more than 
10 line items belonging to the same entitlement, a maximum of 10 fulfillments is rehosted. This limit 
can cause an issue when a producer wants to rehost all fulfillments on a given host and the host is 
activated with an entitlement that has more than 10 line items. 

The following configuration option has been added in this release to enable a producer to rehost all 
available fulfillments for an entitlement during a Batch Rehost. (The 10-fulfillment limit is not 
exercised.)

System > Configure > FlexNet Operations > General Options > Process all line items in an 
Entitlement during Batch Rehost

This option applies to FlexNet Publisher fulfillments only.   

New Option to Handle Multiple Tenants
A new configuration option, multitenancy.disabled, has been added in this release. This option is for 
use by FlexNet Operations On Premises customers who have more than 1 tenant configured in 
LFS_TENANT. By default, this option is set to false. It must be set to true by such customers to ensure 
that they have access to proper FlexNet Operations functionality.  

Search Filters in End-User Portal Enhanced to Obtain Active Fulfillments
The List Licenses page in the End-User Portal now provides additional Advanced Search filters that can 
be used to obtain a list of all active license fulfillments. This can be useful, for instance, when 
consolidating fulfillments because all fulfillments consolidated must be active. To obtain this list, users 
will need to use a combination of the new fulfillment State filter (Active) and the new Line Item State 
filter (Deployed).  
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 SOAP and REST Web Services Enhancements
This section describes the FlexNet Operations SOAP and REST Web Services enhancements introduced 
in 2021 R1. 

Note • The SOAP Web Services are recommended for use by only producers for integration with the 
back office.

• Ability to Search by “Sold To” Account Name When Using “getEntitlementsQuery”

• New Property to Capture the Device Creation Date

• New Batch-size Limits in SOAP and REST Web Services

• lastModifiedDate Parameter Available in searchDevices Request

Ability to Search by “Sold To” Account Name When Using 
“getEntitlementsQuery”
Previously, the getEntitlementsQuery SOAP web service did not allow the ability to filter on the Sold To 
account name. An optional parameter, isSearchByName, has been added to the request type so that 
this filter can be carried out, without changing the way the API operates by default for existing 
integrations.  

New Property to Capture the Device Creation Date
A new createdOn property showing the device creation date is now returned by the getDevice SOAP 
web service request.

This change is implemented as part of the v4 ManageDeviceService web service.  

New Batch-size Limits in SOAP and REST Web Services
The following default batch-size maximums have been implemented for requests issued from SOAP 
and REST web services. Specifying a request with a batch size greater than the limit results in an error.

• All services that result in a write—such as createObject, updateObject, or createOrUpdateObject—
now have a batch size maximum of 25 records.

• All read services—that is, getObjectQuery and similar methods (for example, getEntitlementQuery 
and searchDevices)—now have a maximum batch size of 2000. 

Note that these limits can be adjusted to address the load requirements at your site. To make 
adjustments, the Super Administrator accesses Configure > FlexNet Platform Server > General 
Options and updates either or both options accordingly:   

• Maximum Batch sizes for create/update Webservices requests

• Maximum Batch sizes for read Webservices requests

lastModifiedDate Parameter Available in searchDevices Request
A new parameter, lastModifiedDate, is now available with the searchDevices SOAP web service to 
enable users to filter results by the date that devices were last modified.  
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System Administration Enhancements
The following FlexNet Operations system administration enhancements were included in 2021 R1.

• Custom Message on the End-User Change Password Page

• Configuration to Provide “Privacy Terms and Agreement” for Self-Registering Users

• Administrator Permission to Set CLS Password

• Localization for Certain Custom Content IDs

Custom Message on the End-User Change Password Page
Producers can now add a custom message to the End-User Change Password page (for example, if 
they want to provide more information about password requirements). The content for this message is 
defined using the new configuration setting, System > System Configuration > End User Portal Setup > 
Login Page > Custom Message. Currently, no size restriction is applied to the message text.  

Configuration to Provide “Privacy Terms and Agreement” for Self-
Registering Users
Administrators can now configure a “Privacy Terms and Conditions” link on the Register for Account 
page for self-registering users in the End-User Portal. The options to configure the link—Enable terms 
and conditions panel and Terms and conditions URL—are found in the General Options section of the 
End-User Portal Setup page in System > Configure.  

Administrator Permission to Set CLS Password
FlexNet Operations administrators now have permission to reset the Cloud Licensing Server (CLS) 
producer user password for both existing and future Cloud License Server (CLS) instances. (A producer 
user password is used to obtain Authorization tokens for all instances.) Administrators can set this 
password using the Enable Producer User for CLS option and the associated Producer User’s 
Password for CLS field found in the Embedded Device Settings section of the FlexNet Operations page 
in System > Configure.  

Localization for Certain Custom Content IDs
Producers can now localize the following Custom Content IDs, used to display custom instructions and 
information on specific End-User Portal pages:

•  DownloadContent

• epAnnouncements

• ForgotOrResetPassword

Custom Content IDs are defined using the System > Custom Content page in the Producer Portal. To 
localize the content associated with the IDs listed above, you must add the locale code as a suffix to 
the ID. For example, to localize the epAnouncements content for France, add the “-fr_FR” suffix to the ID:

epAnnouncements-fr_FR

For more information about Custom Content, refer the online Producer Portal User Guide.  
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User Experience Enhancements
This section describes FlexNet Operations user-experience features and enhancements included in 
this 2021 R1 release.

• Rebranding

• Additional Language Support for End-User Portal Localization

• Quick Search for Devices from Producer Portal Home Page

Rebranding
In 2020, FlexNet Operations became a product of Revenera, a new division of Flexera Software. The 
product, user documentation, and related artifacts have been rebranded to display the new Revenera 
logo (replacing the “Flexera” logo) and to redirect links to the Revenera Community and other 
Revenera-related sites. The FlexNet Operations product name remains the same.

Additional Language Support for End-User Portal Localization
The following additional languages are now available for localizing the End-User Portal.   

Language
Locale 
code Language

Locale 
code

Bulgarian bg-BG Norwegian nb-NO

Croatian hr-HR Polish pl-PL

Czech cs-CZ Portuguese (Europe) pt-PT

Danish da-DK Romanian ro-RO

Dutch nl-NL Russian ru-RU

Estonian et-EE Serbian sr-RS

Finnish fi-FI Simplified Chinese zh-CN

Greek el-GR Slovakian sk-SK

Hungarian hu-HU Slovenian sl-SI

Indonesian in-ID Swedish sv-SE

Kazakh kk-KZ Traditional Chinese zh-TW

Korean ko-KR Turkish tr-TR

Latvian lv-LV Ukranian uk-UA

Lithuanian lt-LT Vietnamese vi-VN
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Quick Search for Devices from Producer Portal Home Page
You can now perform a Quick Search for devices from the Producer Portal home page. Once you have 
selected Devices as your search type, use the accompanying drop-down list and text box to further 
refine your search.  

General FlexNet Operations Enhancements
The following general enhancements to FlexNet Operations were included in the 2021 R1 release.

Third-Party Component jQuery Upgrade
The UI for the third-party component jQuery has been upgraded to 1.12.1 for both the Producer Portal 
and the End-User Portal to resolve any issues related to the outdated product.  

System Requirements
Detailed system requirements for FlexNet Operations 2021 R1 On Premises include the following.

Requirement Description

Supported Operating 
Systems

• Microsoft Windows Server 2019 

• Microsoft Windows Server 2016 

• Red Hat Enterprise Linux 8.4 (64-bit)

• Red Hat Enterprise Linux 7 (64-bit) 

• Virtual appliance: Linux (64-bit) based on CentOS-7

Important • All Linux platforms must be Linux Standard Base (LSB) 
compliant.

Supported databases • SQL Server 2019

• SQL Server 2017

• SQL Server 2016 SP2

• SQL Server 2014 SP3
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Servers

Note • For best performance, availability, and reliability, install each 
FlexNet Operations On Premises component on a separate host.

For Windows servers (each)

• Dual core

• 8 GB of RAM for each component (FlexNet Operations, Cloud 
Licensing Service, Usage Analytics Service) 

• Minimum of 10 GB free disk space 

For Linux servers (each)

• Dual core 

• 8 GB of RAM for each component (FlexNet Operations, Cloud 
Licensing Service, Usage Analytics Service) 

• Minimum of 10 GB free disk space 

• Current directory (.) must be in the path of the user who starts the 
FlexNet Operations On Premises server 

For Virtual Appliance

• 8 GB of virtual RAM

• 8 GB of virtual disk space

• VMware requires about three times as much hard disk space at Open 
Virtualization Format package deployment time

Application server WildFly version 8.2.0, with default configured heap space minimum of 4 
GB and maximum of 8 GB 

Message broker 
software

RabbitMQ version 3.6.12 (with Erlang Version Erlang OTP 19(8.3))

Supported Java 
development kits

• Oracle JDK 1.8

• OpenJDK 1.8

Supported web 
browsers 

• Microsoft Edge 

• Mozilla Firefox 75.0 

• Google Chrome 80.0.3987.163 

Requirement Description
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Resolved Issues
Issues in the following areas were resolved in the FlexNet Operations On Premises 2021 R1: 

• Account and User Management Issues Resolved

• Alert Management Issues Resolved

• Device Management Issues Resolved

• Download Package Management Issues Resolved

• Electronic Software Delivery Issues Resolved

Supported FlexNet 
licensing modules 

• Updates and Insights Toolkits .Net 32-bit, .Net 64-bit, C XT-64, C 
SDK-64

• FlexNet Publisher Toolkit 11.16.1.0 or later 

• FlexNet Embedded Toolkit 2015 R2 or later 

Note • FlexNet Operations On Premises supports these FlexNet 
Embedded host ID types: Ethernet, FlexID 9, FlexID 10, String, VM_UUID, 
User, Extended, PUBLISHER_DEFINED, Internet, and Internet6. 

Supported vendor 
certificate generators 

The current versions of the VCG kit are 12.11.0 and 16.2.2.0. 

These VCGs were tested with the following compilers: 

• Windows—Visual Studio 2010 Professional Edition 

• Linux—gcc 4.8.5 (RHEL 7.0) 

• Linux—gcc 4.1.2 (RHEL 5.0) 

Note • The 12.11.0 VCG is built with FlexNet Publisher 11.11.1 and 
shares the same minimum C compiler requirements on each supported 
platform. (See the FlexNet Publisher 11.11.1 release notes for C/C++ 
compiler support.) 

Supported upgrade 
paths

You can upgrade from the following previous FlexNet Operations versions 
to the current version:

• 2017 R4

• 2018 R1

• 2018 R1 SP1

Supported LDAP 
directory servers 

Windows 2012 Active Directory 

Requirement Description
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• Email Notification Management Issues Resolved

• Entitlement Management Issues Resolved

• Export and Import Issues Resolved

• FlexNet Embedded Back-Office Issues Resolved

• FlexNet Publisher Back-Office Issues Resolved

• License Management Issues Resolved

• Product Management Issues Resolved

• Public Services Issues Resolved

• Security Issues Resolved

• SOAP and REST Web Services Issues Resolved

• Usage Management Issues Resolved

• User Experience Issues Resolved

Account and User Management Issues Resolved
The following issues were resolved for the management of accounts and users in the 2021 R1 release.

• Users from Active Directory Group Now Able to Log Into Producer Portal

• Producer Users No Longer Able to Assign Advanced Permissions

• Creation of Users with Email Address Domains Containing Four Parts Now Allowed

• Users Now View Only Those Accounts to Which They Belong

• Attempt to Delete a User Associated with Many Devices Now Completes Successfully

• Buttons on User Creation Page No Longer Disappearing

• Last Login Date for SSO User Now Updating Properly

• Proper Error Message When Producer Creates a User with Same Email as Producer

• Correct Last Login Date for Users Now Listed

• Kanji Characters No Longer Displaying

Users from Active Directory Group Now Able to Log Into Producer Portal
Previously, users from Active Directory groups were unable to access the Producer Portal even though 
the groups were assigned appropriate permissions and belonged to a properly defined domain in 
FlexNet Operations. When the users attempted to log in, they received the following error message: 
“The user linking with account is expired. Please contact your administrator.”

This issue has now been resolved so that users from the Active Directory groups can log in to the 
Producer Portal successfully.  
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Producer Users No Longer Able to Assign Advanced Permissions
Mechanisms are in place so that Producer Portal users can no longer give themselves (and others) 
advanced permissions by using an URL to access the UI to edit user permissions.  

Creation of Users with Email Address Domains Containing Four Parts Now 
Allowed
The End-User Portal now allows the creation of users whose email address contains four tokens in its 
domain part (such as in mary.smith@a.b.example.com).  

Users Now View Only Those Accounts to Which They Belong
Previously, when the Apply Manage Users... system option was in effect, a user (for example, User 1), 
who belonged to the same account as another user (User 2), would be able to remove User 2 from a 
different account even if User 1 did not belong to the different account. This issue has now been 
resolved by providing a user with access to only those accounts to which the user belongs.

The Apply Manage Users permission to users in shared accounts option is configured through System 
> Configure > FlexNet Operations > General Options in the Producer Portal.  

Attempt to Delete a User Associated with Many Devices Now Completes 
Successfully
Previously, when a user was associated with a large number of devices, a request to the FlexNet 
Operations UI or Web Services to delete the user occasionally failed because an internal operation 
timed out. The internal operation has been optimized so that it no longer times out, enabling the delete 
process to complete successfully.  

Buttons on User Creation Page No Longer Disappearing
The Link Account and Remove Account buttons no longer erroneously disappear on the Create a User 
page when the pagination button is clicked.  

Last Login Date for SSO User Now Updating Properly
The date that an SSO user last logged into the End-User Portal is now updating correctly on the User 
page in the Producer Portal.  

Proper Error Message When Producer Creates a User with Same Email as 
Producer
A proper error message now displays when the Producer attempts to create a user account that has 
the same email as the Producer’s account. (The duplicate emails might occur, for example, when the 
Producer uses a data import template to create user accounts.)  

Correct Last Login Date for Users Now Listed
The Date of Last Login field now lists the correct date for a given user on User pages in the Producer 
and End-User portals.  
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Kanji Characters No Longer Displaying
Kanji characters were displaying in the Country field on the Create Account page even though Kanji 
was not the character set of the currently selected locale. Now a value using the appropriate character 
set persists in the Country field.  

Alert Management Issues Resolved
The following issue was resolved for the alert management in the 2021 R1 release.

Issues with Untimely Entitlement Alerts Resolved
In previous releases, users were receiving alerts about entitlements that were not yet near expiration 
or were long past expired. To address this issue, the Expired/Expiring Entitlements job has been 
deprecated and replaced with two new jobs, Expiring Entitlement and Expired Entitlement. When 
producers configure these jobs, users receive timely alerts about entitlements about to expire or have 
expired.  

Device Management Issues Resolved
The following issues were resolved for the management of devices in the 2021 R1 release.

• Trailing or Leading Spaces in Feature Names No Longer Failing Device Series Updates

• Device Permissions Now Properly Enforced Based on Its Account

• Now Only Electronic Software Delivery License Required for Availability of Downloads Tab for 
Devices

• Initial Attempt to Self-Register a Device No Longer Failing

• Configuration to Allow or Disallow Registration of Unknown Devices Now Working Properly

• Unknown Device Registration Now Succeeds on First Attempt

• Return of Devices Successful with or without Destination Devices

• Device No Longer Created with Licenses from Two Different Accounts

• Device Searches No Longer Failing

• Improved Loading Time for Devices Page

• Search and Filter Issue for Device Updates Resolved

Trailing or Leading Spaces in Feature Names No Longer Failing Device Series 
Updates
Previously, when producers attempted to update a device series for FlexNet Embedded, any trailing or 
leading spaces around a feature name prevented the series from being updated. Starting in this 
release, trailing or leading spaces around feature names are ignored during the update process.  
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Device Permissions Now Properly Enforced Based on Its Account
Previously, a user who belonged to multiple accounts—one or more of which had full device-
management permissions—would have full device-management permissions on devices that 
belonged to any of these accounts, even those accounts in which the user had no or limited device-
management permissions.

A new configuration option in the Producer Portal, System > Configure > End-User Portal Setup > 
Devices Page > Enforce device management permission across accounts, now enforces device 
management permissions across all accounts in the End-User Portal. When the option is selected, all 
devices are listed on the Devices page (as in previous release), no matter the account with which a 
given device is associated. However, when a device link is clicked, the capabilities available on the 
Device Details page are based on the specific account to which the device belongs. Consequently, if a 
user belongs to multiple accounts, the user’s device-management permissions are now determined on 
an account-by-account basis, depending on the account with which the currently selected device is 
associated. If a user lacks permissions to return or generate licenses, but can otherwise edit a device, 
these specific restrictions are also enforced strictly for each account.

By default, this option is unselected so that the previous behavior remains in effect.  

Now Only Electronic Software Delivery License Required for Availability of 
Downloads Tab for Devices
The Downloads tab is visible on the Device Details page for a standalone device in the End-User Portal 
as long as the end user has an Electronic Software Delivery license (and the Administrator has set the 
appropriate System Configuration options for the End-User Portal). Previously, the visibility of this tab 
was erroneously dependent on an Updates and Insights license as well.  

Initial Attempt to Self-Register a Device No Longer Failing
Previously, when an unknown device attempted to register using an activation ID for an entitlement 
owned by only a partner account, the first capability request failed with the message: “The activation 
ID was denied.” Consequently, the device was not able to self-register. However, a subsequent 
request would then succeed, and the device was ultimately registered.

This issue has been resolved so that device registration succeeds with the first registration request.  

Configuration to Allow or Disallow Registration of Unknown Devices Now 
Working Properly
The Allow Adding Unknown Hosts and Allow Server Without Activation IDs system configuration 
settings are now working correctly to ensure that unknown standalone and server devices can be 
properly registered or disallowed registration depending on this configuration. Additionally, 
appropriate error messages are now displayed when registration is denied.  

Unknown Device Registration Now Succeeds on First Attempt
Previously, the first capability request sent by an unknown device was denied if that device was 
attempting to self-register with an activation ID for an entitlement owned by a partner account only. 
The self-registration failed, showing the following error in the capability request: The activation ID 
was denied. However, a subsequent capability request would succeed.  

This issue has been resolved so that device registration succeeds with the initial registration request.  
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Return of Devices Successful with or without Destination Devices
The Return Device feature now supports the return of devices with or without a destination device ID. 
Previously, device returns were erroneously requiring a destination device.  

Device No Longer Created with Licenses from Two Different Accounts
Previously, when a capability request was sent containing activation IDs for two or more different 
accounts, a device was created with licenses from all accounts. Now, when such a capability request 
is sent, it is rejected. However, the request is accepted if it has one or more activation IDs for the same 
account.  

Device Searches No Longer Failing
Previously, if an illegal character was present in the device dictionary, an attempt to view details on the 
View Device or View Server page for a selected device failed. This issue has been resolved.  

Improved Loading Time for Devices Page
Changes have been applied to improve the time required to load the Devices page.  

Search and Filter Issue for Device Updates Resolved
The search and filter functionality on the Device Updates tab in the End-User portal is now working 
properly. Previously, when using this functionality, users received a gateway timeout error.  

Download Package Management Issues Resolved
The following issues were resolved for the management of download packages in the 2021 R1 
release.

• Size of Files in Download Packages Now in Binary Format

• Issue with Downloads Incorrectly Tagged as “anonymous user” Downloads Resolved

• Extended File Descriptions with Anchored Tags Now Properly Displaying

• Column Sort Issue on File Download Page Resolved

Size of Files in Download Packages Now in Binary Format
Previously, the size of files in a download package on the Downloads > List Downloads page did not 
match the size of the downloaded files. In this release, file sizes in the End-User Portal are now 
calculated using a binary conversion so that the raw byte size is divided by a power of 2 rather than a 
power of 10, as used previously. For example, with this conversion 1 KB now represents 1024 bytes, 
rather than the 1000 bytes previously calculated. As a result, the Downloads > List Downloads page 
now shows the size of files in the download package in binary format, the same format used for 
downloaded-file sizes, thus eliminating the file-size discrepancies.  
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Issue with Downloads Incorrectly Tagged as “anonymous user” Downloads 
Resolved
Previously, downloads that were not “anonymous user” downloads were logged as such if an end user 
used the Download Now link from the List Entitlements page on the End-User Portal. This issue has 
been resolved.  

Extended File Descriptions with Anchored Tags Now Properly Displaying
When an Extended Description for a file in a download package was defined with anchor tags (such as 
tags to create an HTML link) in the Producer Portal, the description was not displaying properly on the 
Downloads page in the End-User Portal. The description is now displaying correctly.  

Column Sort Issue on File Download Page Resolved
(End-User Portal) Clicking the File Size or File Added column header in the Download Selected Files 
grid on the Downloads page did not properly sort the entries in the grid. These sort techniques are 
working.  

Electronic Software Delivery Issues Resolved
The following Electronic Software Delivery issue has been resolved in the 2021 R1 release.

“List Entitlements” Page Now Showing Download Package Links for Re-
identified Entitlement
Previously, if an entitlement that had an associated download package was re-identified with an auto-
generated entitlement ID, the List Entitlements did not show the package-download link in the End-
User Portal. This issue has now been resolved.  

Email Notification Management Issues Resolved
The following issues involving email notifications have been resolved in the 2021 R1 release.

• Issues with Account Keywords and Merge Tags Resolved

• Title Length Errors for Template Variations Now Properly Handled

• Issue with Incorrect First Names Used in Emails Resolved

• Email Template Now Localizing Characters Correctly

• Emails No Longer Being Sent in Draft Status

Issues with Account Keywords and Merge Tags Resolved
Previously, the Entitlement and Entitlement Certification email template had the following issues:

• The Account keyword was not retrieving account-related merge tag details.

• The merge tag [[AcctName]] retrieved no information, resulting in a blank in the generated email 
or certificate.
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These issues have been resolved in the current templates.  

Title Length Errors for Template Variations Now Properly Handled
Previously, when users created an email template variation with a title that exceeded the maximum 25 
characters, FlexNet Operations did not handle the error in a helpful way. A meaningful error message is 
now provided.  

Issue with Incorrect First Names Used in Emails Resolved
Previously, when an account had multiple users, a notification email sent to any of these users could 
contain the first name of any of the account's users in the greeting. This issue has been resolved so 
that the correct first name of a given recipient is used in that recipient’s email.  

Email Template Now Localizing Characters Correctly
The issue with the email templates not displaying characters in other languages correctly in email 
subject lines and other locations has been resolved.  

Emails No Longer Being Sent in Draft Status
Email notifications could be inadvertently triggered when the email template was in draft status. The 
logic behind when email notifications are sent has been updated to prevent their being sent when the 
template is still in draft status.  

Entitlement Management Issues Resolved
The following issues were resolved for entitlement management in the 2021 R1 release.

• Activation ID Link Now Properly Opening Entitlement Details Window

• Bulk Upgrades with Embedded Licenses Successful

• Correct Available Count Showing on Entitlement Transfer Page

• Attempts to Reduce Entitlement Quantities Now Successful

• Removal of Source Account in Entitlement Merge Now Successful

• Users with Italian Locale Now Able to Perform Entitlement Transfers

• Returned FlexNet Publisher Licenses Now Reflected in Line Item Counts

• Correct “Available Quantity” Values Now Show in Line items in End-User Portal

• Changes to Line Items Now Shown on License Server

• Bulk Entitlement Issue with User-Supplied Web Register Keys Resolved

• Licensing Issue with Vendor-Defined Hostid of “Any” Resolved

• Appropriate Distribution Tier Now Displaying

• Batch Rehost Error for Producer Users Resolved

• Merge Entitlements Now Properly Working
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• Improved Error Message for Out-of-Range Start Date

• Improved Performance for Loading Entitlements Pages

• Auto-Provisioning Failures Addressed

• Correct License Count After Certificate License Returned

• Issue with Lost Entitlement Counts Resolved

Activation ID Link Now Properly Opening Entitlement Details Window
In the End-User Portal, clicking an activation ID on the List Entitlements page resulted in an error 
message. This issue has been resolved. Now, clicking an activation ID link opens the Entitlement 
Details window, which lists the activation details.  

Bulk Upgrades with Embedded Licenses Successful
Bulk upgrade jobs complete without errors with embedded licenses.  

Correct Available Count Showing on Entitlement Transfer Page
The Transfer Entitlement Line Item page now displays the correct available count for the transfer of an 
entitlement line item from a source to a target account in both the Producer Portal and the End-User 
Portal.  

Attempts to Reduce Entitlement Quantities Now Successful
In some cases previously, producers were not able to reduce the quantity of a line item for a FlexNet 
Embedded entitlement even though the entitlement had no active fulfillments or still had some line 
items yet to be fulfilled. (The issue was related to FlexNet Embedded entitlements created before 
December 3, 2020.) This issue has now been resolved.  

Removal of Source Account in Entitlement Merge Now Successful
Previously, after the entitlements for an account belonging to one organization had been merged with 
the entitlements of another account for a different organization on the same host, an attempt to delete 
the source account for the merge could fail. The deletion of the source account now completes 
successfully.  

Users with Italian Locale Now Able to Perform Entitlement Transfers
Previously, users with the locale value Italian (it_IT) were unable to transfer entitlements in the End-
User Portal. This issue has been resolved.  

Returned FlexNet Publisher Licenses Now Reflected in Line Item Counts
Previously, counts for returned FlexNet Publisher licenses were not being updated to the associated 
entitlement line items. This issue has been resolved.  
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Correct “Available Quantity” Values Now Show in Line items in End-User 
Portal
Line items for FlexNet Embedded entitlements on the List Entitlements page in the End-User Portal 
now display correct values for Available Quantity (for example, when compared with the correct Qty 
Remaining value on the Entitlement Details pop-up). This issue was found in those FlexNet Embedded 
entitlements that were created and fulfilled before December 3, 2020.  

Changes to Line Items Now Shown on License Server
Previously, in some cases when an entitlement line item was updated (for example, to extend an 
expiration date), the changes to the line item were not displaying on the relevant license server. The 
situations that caused this issue have now been resolved.  

Bulk Entitlement Issue with User-Supplied Web Register Keys Resolved
Previously, when a user attempted to create a bulk entitlement using an imported xml file to generate 
user-supplied Web register keys, the bulk entitlement job succeeded. However, emails and alerts were 
not triggered, and the Web register keys were not generated. This issue is now resolved so that, when 
a bulk entitlement is created as such, the Web register keys are generated and the emails and alerts 
are triggered.  

Licensing Issue with Vendor-Defined Hostid of “Any” Resolved
Previously, users could create a license using the VENDOR_DEFINED keyword with a hostid of ANY. The 
resulting license file contained the keyword HOSTID=ANY, enabling the license to be used on any 
device. For some producers, the ability to use the license on any device created the potential for 
license leakage.

Now, if users attempt to generate a license using a hostid of ANY for the VENDOR_DEFINED keyword, 
an error is thrown along with a message stating that the hostid is invalid. However, existing license 
files created in this manner prior to 2020 R3 SP2 continue to work as before.  

Appropriate Distribution Tier Now Displaying
When you add an account to an entitlement, the Distribution Tier value on the End Customer and 
Channel Partners window now shows the correct tier as you toggle between the Partners and 
Customers tabs. This fix ensures that the entitlement is created with the correct tier for the selected 
account type.  

Batch Rehost Error for Producer Users Resolved
Previously, a batch rehost failed with an “unexpected error” for those Producer users who did not have 
product line ALL assigned to them. In this release, batch rehost succeeds for all Producer users.  

Merge Entitlements Now Properly Working
Previously, when you attempted to merge entitlements that were activated on the same host, the 
merge failed. You can now perform this merge scenario successfully.  
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Improved Error Message for Out-of-Range Start Date
A more helpful error message now displays when a user attempts to create an entitlement with an out-
of-range or unacceptable start date.  

Improved Performance for Loading Entitlements Pages
Changes have been applied to improve the time required to load the List Entitlements and List 
Entitlements by Order pages in the Producer Portal and End-User Portal.  

Auto-Provisioning Failures Addressed
Auto-provision could fail if an entitlement creation coincided with restarting an FlexNet Operations 
component. This issue has been resolved so that the auto-provision re-try is now successful.  

Correct License Count After Certificate License Returned
The List Entitlements view in the End-User Portal was not showing the correct license count when a 
FlexNet Publisher certificate license was returned. The correct license count is now displayed.  

Issue with Lost Entitlement Counts Resolved
Previously, a “missing counts” issue occasionally occurred that affected the accuracy of the counts of 
available licenses for those entitlements using embedded license models. With the fixes in this 
release, the figures displayed in the UI for the available and consumed licenses are now always 
correct, reflecting the actual usage at any given time. The pages affected by this issue include the 
following:  

• Devices

• Entitlements

• Line items

• Device map add-on

• Map by activation ID

Export and Import Issues Resolved
The following issues involving export and import have been resolved in the 2021 R1 release.

Downloads Now Available to End Users for Entitlements Created with Data 
Import Template
Previously, when entitlements were created using a data import template, an Electronic Software 
Delivery download link would be available in the End-User Portal for only the last line item of each 
entitlement. This issue has been resolved so that links to all items in the entitlement are available.  

Exported Expiration Date for Entitlement Lines No Longer Incorrect
During an export, the entitlement line expiration date was off by one day. This issue has been resolved.  
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FlexNet Embedded Back-Office Issues Resolved
The following FlexNet Operations issue related to FlexNet Embedded was addressed in the 201 R1 
release.

Borrow Interval Now Handled Correctly with Specified Granularity
The issue of the borrow interval not always working properly in combination with the borrow 
granularity has been resolved.  

FlexNet Publisher Back-Office Issues Resolved
The following FlexNet Operations issues related to FlexNet Publisher were addressed in the 2021 R1 
release.

Errors Resolved in Creation of Local Trial ASRs
The following issues in the creation of local trial ASRs have been resolved:

• Previous attempts to create local trial ASRs could result in a hibernation error if the ASR requested 
features with long names or a large number of features. This issue has now been resolved.  

• Previous attempts to create a local trial ASR in the Producer Portal could fail with unexpected 
error. The error is resolved, and the creation of a local trial ASR now completes successfully.  

Searches on ASR Pages Now Working
A search by Product or Part Number from any ASR page now functions properly. Previously, searches 
based on either criterion could erroneously return empty results.  

License Management Issues Resolved
The following issues involving license management and models were resolved in 2021 R1 release.

Feature Names with “SERVER” No Longer Truncated in Trusted Storage
In previous releases, a feature name that contained the string “SERVER” was truncated when the 
feature was activated in trusted storage. This is issue has been resolved so that the full feature name 
is now retained in trusted storage.  

Spaces at Beginning or End of License Model Names Removed
FlexNet Operations now trims any spaces located at the beginning and end of license model names to 
avoid potential processing errors.  

Correct Available License Counts Displayed
Previously, in certain cases an incorrect data source was being used to calculate available license 
counts, resulting in incorrect available counts being presented. This issue has been resolved so that 
the correct data source is used to present accurate counts.  
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Product Management Issues Resolved
The following issues involving product management have been resolved in this release.

• Last Modified Date Now Updated Only When Product Configuration Changes Saved

• License Model Value for Product Part Number Now Updating Properly

• Successful Product Mapping to a Product Line with a Multi-Line Attribute

• Only Product Lines Associated with User Displayed

• Partners No Longer Able to Select Non-Related Accounts on Entitlements Pages

Last Modified Date Now Updated Only When Product Configuration Changes 
Saved
Previously, simply navigating through the details for a product resulted in the product’s Data Modified 
field to be updated. Now the field is updated only if the changes to the product’s configuration have 
been saved.  

License Model Value for Product Part Number Now Updating Properly
Previously, when a different product was associated with a part number on the Create a Part Number 
window, the License Model selected for the new product was not saved once the user clicked Save. 
This issue is now resolved.  

Successful Product Mapping to a Product Line with a Multi-Line Attribute
Previously, when a product line had an attribute whose type was multi-line, users could not map 
products to the product line. This issue has been resolved.  

Only Product Lines Associated with User Displayed
Previously, the Product Lines page in the Producer Portal was showing product lines not associated 
with the current user. Now this page shows only those product lines associated with the user.  

Partners No Longer Able to Select Non-Related Accounts on Entitlements 
Pages
Previously, when a Partner user typed an account name directly in a source or target account field on 
the Transfer Entitlement or the Merge Entitlements page, an automatic dropdown listing accounts 
that started with the typed character sequence incorrectly allowed the user to select an account not 
related to the Partner account. 

Now, when a Partner user types in these fields, only those accounts associated with the Partner 
account are available for selection.  

Public Services Issues Resolved
The following issues involving Public Services were resolved in the 2021 R1 release.
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Special “publicservices” REST API Now Returning Correct License Counts
The publicservices REST API is a special interface used by some producers to return license counts for 
an activation or entitlement ID.

Previously, this API could return an incorrect “remaining licenses” count for a given activation ID. If the 
API was called as part of an activation process, the incorrect value in the response could cause the 
activation to fail. The publicservices API is now returning the correct license counts for a given 
activation ID.  

“EntitlementDetails” Public Service No Longer Generating Error for Missing 
Grace Period
A license model can designate that the value for certain attributes (such as Grace Period, Renewal, 
Overdraft) be defined at the time an entitlement line is created for any product to which the license 
model is assigned. Additionally, providing a value for any of the attributes is optional. When the 
EntitlementDetails public service was run against an entitlement containing entitlement lines in which 
a value was missing for one of these attributes, the service generated an error message similar to this: 
“The attribute <attribute name> days is not a valid numeric type.”

This issue has been resolved so that, when an attribute that is designated as optional for an 
entitlement line has no value, the EntitlementDetails public service no longer throws an exception.  

Security Issues Resolved
The following security issues have been resolved in this release.

Restricted Directory Access
As a preventative measure based on a recently announced security vulnerability, a security constraint 
has been implemented to restrict access to the WEB-INF directory.  

Possible Security Issue Addressed in the End-User Portal
A security issue has been addressed in the End-User Portal where the URL could be compromised, 
giving unwarranted access to a Producer’s account list to a customer or partner user.  

Resolved Security Issue Detected by WhiteHat
An information-leakage issue involving the System > About Advanced Management Lifecycle Module 
page has been resolved.  

SOAP and REST Web Services Issues Resolved
The following issues related to FlexNet Operations SOAP and REST web services were addressed in the 
2021 R1 release.

• Appropriate Error Now Produced When Transferred Counts Exceed Available Counts

• Feature Replacement for Deployed Products Now Working Properly

• Part Number Associated with Product Now Properly Handled During Product Entitlement
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• Milliseconds Separator No Longer Included in Returned Usage Data

• Last Modified Time for Line Items Now Reported Accurately

• “getActivatableItemsQuery” Web Service Results Now Show Correct Number of Copies for Line 
Items

• Incorrect Entitlement Data No Longer Extracted After Entitlement Updates

• Counts Now Consistent for “searchEntitilement...” Web Services

• EntitlementOrderService Issue Resolved

• Data Extracts Now Properly Encoded

Appropriate Error Now Produced When Transferred Counts Exceed Available 
Counts
Previously, the transferLineItem method in the EntitlementOrderService SOAP web service 
erroneously permitted the transfer of line item counts from one entitlement to another when the 
requested transfer count was greater than the number of licenses available in the source entitlement.

Now, the transferLineItem method throws an appropriate error when users attempt to transfer line 
item counts that exceed the number of licenses available in the source entitlement. (The transfer 
succeeds, however, when the transfer count is less than or equal to the available license count.)  

Feature Replacement for Deployed Products Now Working Properly
The REPLACE operation for individual features in the updateProduct SOAP web service now properly 
replaces a given feature in a deployed project (as long as the editing of deployed products is allowed).  

Part Number Associated with Product Now Properly Handled During Product 
Entitlement
Previously, if the part number for a product that was being entitled was not included during the 
creation of an entitlement through the EntitlementOrderService SOAP web service, the part number 
associated with the product was still shown in the End-User Portal. This has been fixed. Now, if the 
part number for a product being entitled is not included in the web service request, the part number 
associated with the entitled product is no longer assigned by default.  

Milliseconds Separator No Longer Included in Returned Usage Data
In the data returned for the Usage data extract REST API, the timestamps for Transaction Time and 
Received Time were showing a period (.) as a milliseconds separator even though a milliseconds value 
was not intended to be included in either timestamp.

2020-08-18T02:09:28.-0700

The unnecessary period could cause parsing issues and has now been removed.  

Last Modified Time for Line Items Now Reported Accurately
The lastModifiedDateTime attribute for an entitlement line item now gets updated internally with every 
checkout or return of a license. As a result, this value (in UTC format) is now accurately reported in the 
lastModifiedDateTime field in the response for the getActivatableItemsQuery SOAP web service.  
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“getActivatableItemsQuery” Web Service Results Now Show Correct 
Number of Copies for Line Items
Previously, in the response for the getActivatableItemsQuery SOAP web service, information for given 
entitlement line items could occasionally show out-of-date values for the number of remaining and 
fulfilled line-item copies. This issue is now resolved.  

Incorrect Entitlement Data No Longer Extracted After Entitlement Updates
Previously, the Entitlement data extract could show incorrect information if the expiration date or any 
other entitlement field had been updated using either the SOAP web service method 
updateEntitlementLineItemRequest or an import job for update entitlement. This issue has been 
resolved so that the extract now presents correct data.  

Counts Now Consistent for “searchEntitilement...” Web Services
Web Service calls to searchEntitlementRequest and searchEntitlementLineItemPropertiesRequest 
were returning different available count totals for the same activation ID. This issue has been resolved 
so that the counts are consistent.  

EntitlementOrderService Issue Resolved
The error generated when you attempted to update or create entitlements concurrently using 
EntitlementOrderService methods has been resolved.  

Data Extracts Now Properly Encoded
Previously, extracts were not being properly UTF-8 encoded. The extracts are now properly formatted 
in UTF-8.  

Usage Management Issues Resolved
The following issue for FlexNet Usage Management (for producers) was resolved in the 2021 R1 
release.

Issues with Activation ID Case Sensitivity in License Usage Searches 
Resolved
Previously, the case-sensitivity issues occurred with the activation IDs provided during searches for 
license usage information on devices. License usage searches are now case-insensitive.  

User Experience Issues Resolved
The following issues involving user experience have been resolved in the 2021 R1 release.

Text in the FlexNet Operations End-User Portal Now Properly Localized
Certain error and confirmation messages, input field labels, and instructions in the FlexNet Operations 
End-User Portal were not being properly localized. These localization issues have now been resolved.  
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Misdirected Page Issue Resolved
Previously, when a user attempted to self-register through the FlexNet Operations UI running in a 
Firefox browser and provided an email address that exceeded the maximum size, the expected error 
popup was displayed; but, when the user clicked OK to close the popup, the UI displayed a blank page.

This issue is now resolved so that, when this error popup is closed, the user is properly directed back 
to the login window.  

Password Issue Addressed
Previously, an encryption error was generated when resetting a password if the old password 
contained special characters. The old password is now properly encrypted during the reset process.  

Known Issues
The following are known issues in FlexNet Operations.

Geographic Restrictions Fields Displayed But Currently Not in Use
The Restrict Access to Selected Countries fields, which are displayed on the Restrict Download 
Package page (accessed from the View Download Package page in the Producer Portal), are currently 
not in use. In a future release, producers will be able to use these fields to define geographic 
restrictions that control which download packages are available to accounts in the End-User Portal 
(based on an account’s country/region).

SWM-7786: SHA2 checksum value of previous file shown
If a file image is subsequently deleted, and the Upload File page is opened again, the SHA2 checksum 
value of the previously loaded file image is shown.

SWM-6996: Updating device “Site name” property to blank not handled 
properly
If you change the Site name value for a device to a blank, the edited property reverts to its original 
value instead of maintaining the blank. This issue occurs when you make the change either through 
the Devices UI in the Producer Portal or End-User Portal or through the updateDevice method in the 
ManageDeviceService SOAP web service.

SWM-5894: Changes and limitations to the updateDevice SOAP method
The updateDevice method in the V3 and V4 ManageDeviceService SOAP web service has the following 
limitations and changes:

• Single channel partner recommended in channel partner list

• Support for only Replace operation in channel partner list
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Single channel partner recommended in channel partner list

As in the previous release, the updateDevice method supports a list of channel partners. However, 
because a device is currently limited to one channel partner, the web service code, in turn, considers 
only one channel partner for the method. Therefore, you are strongly recommended to include only one 
partner in the channel partner list. If the list contains more than one channel partner, the behavior of 
updateDevice method is unpredictable.

Support for only Replace operation in channel partner list

Previously, the opType element, required for managing a channel partner list for the updateDevice 
method, had three possible values: Add, Delete, or Replace. This element now supports only the 
Replace value. If you specify Add, Delete, or Replace or omit the element altogether, the method will 
always use Replace. (If you attempt to specify Add or Delete, a message is returned in the response, 
explaining that Replace was used instead.)  

SWM-2901: CreateContextCSV error during FlexNet Operations deployment
During the deployment of FlexNet Operations (after FlexNet Operations Setup is completed), you might 
see the following error in the logs:

ERROR flexnet.operations.reporting.talend.CreateContextCSV - /root/FlexNet-Operations/
components/wildfly/standalone/configuration/context.csv

This error is “benign” and will not affect the operation of FlexNet Operations in any way.  

FNO-63827: Downloads sometimes not available to end users when 
accounts are re-identified
When a new account is set up with an account ID previously used by a different account, and a user 
who belonged to the original account is assigned to the new account, that user is unable to see 
Electronic Software Delivery download links in the End-User Portal.

FNO-62953: Installer support for UI mode only
FlexNet Operations components are installed using an Install Anywhere installer. The installer can run 
only in UI mode; console mode is not supported.  

FNO-61266: Translation issues with localization
Per the enhancement Additional Language Support for End-User Portal Localization available in this 
release, certain strings, such as alerts and validation messages, in the End-User Portal are not being 
translated properly when localization is in effect. These issues will be addressed in an upcoming 
release.  

FNO-60845: Size limitation for license models
A License Model definition is stored in JSON format in the database. Additionally, the definition is 
transformed into an internal representation, which is also stored in the database for use by the server. 
Currently, the Model definition or its transformation cannot exceed 8000 bytes in length.  
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FNO-60552: Reporting Tab not available after Super User log-in
The Reporting tab is not displayed when a user with the Super User role logs into FlexNet Operations. 

Workaround: After logging in as a Super User, click the Home tab. This action causes the Reporting tab 
to display.  

FNO-60241: Entities not replicated properly to Electronic Software Delivery
In some cases, entities, such as download packages and newly created entitlements, are not being 
properly replicated in the Electronic Software Delivery (ESD) for deployment.

Workaround: Update the entity again.  

NullPointerException error generated for missing role in the 
updateDomainUsersRole method 
The SOAP Web Service UserAcctHierarchyService method updateDomainUsers, when supplied with an 
email and organization value, must also have a roles parameter defined. Failure to add this parameter 
results in a “NullPointerException” error, rather than a clearly worded error.  

The following shows the parameter that must be included in the XML request format to avoid this error:

Special Notes
This section contains special information pertaining to FlexNet Operations:

• Special Requirement for Using High-Speed File Upload Functionality

• Support for SQL Server Database Only

• Best Practice for Uploading New File Versions for Electronic Software Delivery

Special Requirement for Using High-Speed File 
Upload Functionality

If you intend to use the high-speed upload option to upload files, upgrade the Aspera plug-in to Aspera 
Connect 3.10.0 or later.
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Support for SQL Server Database Only
This version of FlexNet Operations On Premises supports the SQL Server database only. It does not 
support the Oracle database. See System Requirements.

Best Practice for Uploading New File Versions for 
Electronic Software Delivery

The following practice helps to prevent the delivery of “stale” file content to your customers.

When you upload a new version of a file (or package) whose previous version exists in the Electronic 
Software Delivery system, best practice is to give the new file version a unique name, different from 
the name of the existing file version. (For example, use a version number in the file name.) Try to avoid 
simply uploading a file using the same name as the existing file so that the existing file is overwritten. 

If you must upload a new file using the same name as the existing file, delete the existing file and wait 
10-15 minutes before uploading the new version. This process will reduce the probability of re-
caching the old content.
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Legal Information 
Copyright Notice
Copyright © 2021 Flexera Software

This publication contains proprietary and confidential information and creative works owned by 
Flexera Software and its licensors, if any. Any use, copying, publication, distribution, display, 
modification, or transmission of such publication in whole or in part in any form or by any means 
without the prior express written permission of Flexera Software is strictly prohibited. Except where 
expressly provided by Flexera Software in writing, possession of this publication shall not be construed 
to confer any license or rights under any Flexera Software intellectual property rights, whether by 
estoppel, implication, or otherwise.

All copies of the technology and related information, if allowed by Flexera Software, must display this 
notice of copyright and ownership in full.

Intellectual Property
For a list of trademarks and patents that are owned by Flexera Software, see https://
www.revenera.com/legal/intellectual-property.html. All other brand and product names mentioned in 
Flexera Software products, product documentation, and marketing materials are the trademarks and 
registered trademarks of their respective owners.

Restricted Rights Legend
The Software is commercial computer software. If the user or licensee of the Software is an agency, 
department, or other entity of the United States Government, the use, duplication, reproduction, 
release, modification, disclosure, or transfer of the Software, or any related documentation of any kind, 
including technical data and manuals, is restricted by a license agreement or by the terms of this 
Agreement in accordance with Federal Acquisition Regulation 12.212 for civilian purposes and 
Defense Federal Acquisition Regulation Supplement 227.7202 for military purposes. The Software was 
developed fully at private expense. All other use is prohibited.

https://www.revenera.com/legal/intellectual-property.html
https://www.revenera.com/legal/intellectual-property.html
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